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Welcome

With the LanBox-LC system 
you've bought a modern desktop 
DMX lighting controller that can 
compete with the best. We hope 
you will enjoy working with your 
LanBox.

What is in this manual?
This manual is divided into four 
chapters. The first part is an 
introduction and description of 
definitions. Part 2&3 describes all 
commands of LCedit+. In the last 
part, overviews are shown.

Note: The LCedit+ was designed 
for the Macintosh platform 
(including OS X, as picture 
shows), but we also have a 
Windows 98SE/2000/XP 
version.. 
 

What is LCedit+?

LCedit+ is a computer program for editing the light cues, sequences and shows inside the LanBox. In other 
words, LCedit+ is just a friendly way to program the LanBox, all the "real" lighting work is done by the box. 
The program has several types of windows: Stage (that holds the fixtures and light groups), Cast (lists all 
used fixtures and groups as a list), Control (for light-, and layer- sequencer control, setting layer and chaser 
parameters ), Cuelist editor (for creating & editing of cues), and Monitor (to monitor various in/out values) .

LCedit+ also has several built-in tools e.g. to edit the fixture library, to manage files (Utilities, Backup and 
Restore), to upload firmware, to edit global settings of a LanBox (e.g. set name, password) and to make 
patches (DMX channels, curves, slope limits, etc.). In order to make fast usage for power users possible, 
LCedit+ also has a CLI (Command Line Interface), user definable presets, key sequences, macros etc.

Besides being a light editing program LCedit+ can be used to trigger light scenes and queues during 
performances. If you need a more specific run time control program (i.e. jingle machine with light queues) , 
you can use a MIDI sequencer (like Performer or Logic), use a show control program or built your own one 
with MAX (examples are included).
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What's in a name

In order to understand what we are talking about when describing the working of LCedit+, we have to make 
clear what we mean with some wordings. 

• LanBox: The hardware in which all lighting programs are stored and executed. We have four types of 
LanBoxes, the LC (the classic one), the LCX, the LCE and the LCM.

• LCedit+: The lighting editor for LanBox-LCX, LCE, LCM, LanBox-LC with LC+ firmware.
• Layer: Is where incoming DMX values from memory (or network/serial/MIDI) are sent to the mixer, via 

faders. It also contains a sequencer and chaser for auto loading of steps from memory. There are 31 layers 
(8 in LC), which feed their DMX values in layered fashion to the mixer. The layer at top of the list has the 
highest priority, see also the LanBox hardware manuals. Note: With the LCX and LCM layers can be 
reordered in priority on the fly.

• Channel: A channel is numbered from 1 to 250 (512, 3072) and contain a value from 0 to 255. It 
represents intensity, colour, gobo, etc. of a fixture. Channels are mapped to DMX addresses with the DMX 
patcher, and are default 1 to 1.

   A channel can be active (black DMX values) or inactive (grey DMX values). Only active channels are 
written into a scene. A channel's output status can be on or off, only when a channel's output is on, the 
DMX value is fed into the mixer.

• Cuelist: There can be 500 cuelists in a LanBox-LC+ (999 in LCX and LCM). Each cuelist can hold up to 
99 cuesteps. A cuelist can have one or more Cues.

• Cuestep: Most of the time a cuestep is linked to a light scene and is called a Cue when the hold time is for 
ever, but it can also hold only instructions for the engines, sequencers and/or faders.

• Cue: xx
• Scene: The static channel value of one or more channels are stored in a scene and is linked to a cuestep, 

from that moment it's called a Cue.
• Mixer: It's the mixer's responsibility to bring together the output values of all layers in a defined way into 

a "mixed" single result per channel.
• Sequencer: The mechanism which automatically loads cue steps in sequence and continues to do so, until 

the end of a cue list. The sequencer can be instructed to behave differently by special actions and/or the 
chaser.

• Faders: Are responsible for smooth transitions from one lighting scene to another. Fades can have 
different behaviours (in, out, cross, etc.) and it's duration can be instructed.

• Chaser: The chaser changes the behaviour of the sequencer like stepping reverse, endless, random, etc. 
When the chaser is in charge, the step hold times can be changed between 50% and as fast as possible.

• DMX patcher: Maps light channels into one or more physical DMX addresses.
• DMX gain (Master Intensity): Is multiplied with the DMX value, and can have a range of 0..200%. The 

default value is 100% (128).
• DMX curve: There are 7 user definable curve tables, which can be used to correct a dimmer curve, to 

invert a pan/tilt channel(s), but also for flashing/blackouts.
• DMX slope: In order to prevent high rush-in currents of certain lamps, you can set the maximal rate of a 

DMX value change with the slope setting. Default is unlimited speed.
• Panel: All fixture types are constructed from standard built-in panels.
• Fixture: A lighting device that can handle command(s) like intensity, colour, gobo, position, focus, beam-

width, etc. LCedit+ supports standard several fixture types, but they can also be constructed by the user.
• Group: When one or more channels of a fixture are put together, based on function (intensity, colour) or 

location like "Stage left front", it is called a group. With LCedit+ you can create unlimited groups, in any 
way you want.

• CLI: Command Line Interface, a very fast (but a bit cryptic), way to work with LCedit+ by means of keys.
• Option Key: A Macintosh modifier key, use the Alt key with Windows.
• Command Key: A Macintosh modifier key, mostly the Ctrl key with Windows. 
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Stage window

You can place as many fixtures and/or groups on the stage(s) as you want 
with the menu commands "New Fixture" and "Make Group". When your 
fixture is not in the library, use the nearest model, place separate generic 
channel fixtures, or create your own fixture with the library editor.

Important: Place single channel fixtures even if you use multichannel 
dimmer packs! The multi channel packs in the library are intended for 
unknown multi channel fixtures, not for dimmer packs.

Note: You do not need to fill in the blank channel and DMX fields, as they 
will be assigned automatically. The idea is to organise your fixtures in a 
way you can find them quickly and represents the real stage. When fixtures 
are placed on the stage there are assigned to channel numbers, but that can be changed in the fixture setup.

Note: Do not change the channel numbers once you have created cuesteps, but use the Edit Item command 
of a fixture to match the DMX addresses of the fixtures with channels.

The fixtures (or groups) can be created, deleted and duplicated with menu commands and shortcuts. 
Selecting an item instantly changes the content in the control panel, reflecting the state of the fixture or 
group. Once a fixture or group is selected (e.g. with the k1 command) you can navigate selections by using 
cmd-opt- arrow up/down (on PC ctrl-alt-arrow up/dwn), you can even extent the selection by also pressing 
the shift key.

When you hold the control key, the stage enables a popup menu with commands to Cut, Copy, Paste and 
clear the background picture. The background can be moved with option-control drag the background 
picture.

Fixtures setup

When a fixture on the stage is selected, it's settings 
can be changed by the menu command "Edit 
Item.." (or double click the icon). Many parameters 
of the fixture can be changed in the Fixture setup 
window, but it's initial use will be to change the 
lighting channel and the used DMX address.
Note: If you don't supply a short name, the long 
name will be used instead.

Other parameters that can be changed are:

• The fixture type (Check in the cast list that the new used channels do not overlap already placed fixtures).
• The used DMX address and LanBox interface.
• The stage icons (paste your own icons), long and short name (The long name is used in: the cast list, the 

title of the Control Window, the library editor window, and in the fixture selection listbox in the fixture 
dialog. The short name is used: On the stage and in general, in other places where there's not a lot of space 
available).

• Per channel the DMX address, the gain, the used curve and the slope limit. You can also change the 
predefined curves 1..7. Note: Curve 1 is normally linear inverse, to be used to invert pan/tilt controls)

• To build a custom fixture (group of channels), in a way it was before LCedit+ v2.0. Normally you should 
use the library editor in order to create a fixture definition.

• Custom presets for this fixture can also be added/changed here, but can also be quickly added in the 
control window.

Edit and control fixtures
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Group setup

LCedit+ offers you to create almost any combination of (sub-) 
grouping in any way you want. Just select one or more fixtures 
(but also previous defined groups are allowed) and do the 
command "Make Group". On the Mac you can also make the 
selection and option-cmd-drag (just as create alias). When groups 
are placed on the stage they are assigned to merge and show only 
"Identical" panels.

The group setup window allows you to add, delete and reorder the 
contents of a group. It's also possible to change the name of the 
group and paste a custom icon.
 

View options

The fixture and group icons on the stage window can have two sizes (or none). Also 
fixtures with a trackball can have a position indicator, while all fixtures have optional an 
intensity indicator. All placed fixtures and groups do get an internal number, which can 
be made visible also (very useful when using the CLI). All indicators are displaying the 
mixer DMX values of the LanBox.
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The Control Window (right part)

The expanded (click the "advanced.." triangle) control window looks very complex with all the buttons and 
indicators, but as it's all organised into sections, it's not that hard to understand.

Note: There are four important key shortcuts: the u, v, x and y. The u selects the Go field, the v, x and y 
selects the Intensity, Pan and Tilt fields respectively. Let's explain all the controls section by section, starting 
with the right half of the control window:

• Command macros: From the dial, display a macro that can be choosing 
ready to run.

• Layer control: Shows the latest loaded cue, with a button to "Go" to any 
cue. The Edit button can be used to create an edit layer using current cue 
number. The five cue manipulation buttons are in order, to clear (deactivate 
all channels), step back, pause, start/stop and go next.

• Layer list: Active layers are shown in order of priority and can be 
reordered by dragging a layer (on LCX & LCM only). Each layer shows 
it's status (edit, run, stop, etc), the current cue number and layer ID like [E] 
(layer label). When the sequencer is running, the progress bars indicate the 
progress in hold and fade time. Depending on the options set in a layer 
there can be more indicators which shows these exceptions.

• Masters: Five small master buttons can be used to disconnect this engine 
global from the mixer (no mix), to disable the faders, to turn on Solo 
actions, to turn off the Auto Output feature and lock this layer from 
deleting. If you set one or more of these options it will be indicated in a 
layer as a small icon.

• Manual fading: Even in manual control you can instruct the layer to fade 
in a certain time when you change channel value(s). This feature can be 
very useful for inserting a cue on the fly with the i-cue panel mode, or just 
for manual control.

• Chaser and mixer: The chaser popup shows several chase modes, while 
the chase speed can be changed between 50% and infinite. The fixture 
values of an engine is mixed by one of several methods, like Copy, HTP, 
LTP, transparent or Add (LCX & LCM only) by the mixer popup button.

• Other: The "+" and trash buttons are quick buttons for the New Layer and 
Delete Layer menu commands. The ID of a layer can be set from "A" to 
"BK" (not on LC). With the MSC field you can set the MIDI Show Control ID of a layer.

• Single Step Edit at: Shows the cue number/step at which the current fixture settings can be Appended, 
Replaced, Inserted or Deleted. Furthermore the action of current step is shown and there is a row of edit 
buttons. The step action field (above the edit buttons) shows the current action, but can be changed by 
clicking in the field (only in edit mode). When the relative button is pressed, the data will be used relative 
to the previous step (LC only). Note: When the cue field contains just a cuelist number (no decimal point), 
the delete button acts as delete entire cuelist (just as Go acts as create list).

• Interface status: An interface status message field and memory indicator completes the right half of the 
control window. Refresh indicates whether auto refresh is on (green), have communication problems 
(orange) or manual refresh (white). The Ld bar indicates the loading of the LanBox, while the lock button 
can be used to lock this window (when multiple control windows are used). 

Edit and control fixtures
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The Control Window (left part)

The left part of the control window is almost empty when no fixture or group is selected on the stage. The 
whole area below "Master Intensity" of Fixture controls is dynamically built on select and can vary from 
only one panel for simple lights, up to over 20 panels for complex fixtures.

• i-cue: When you press the i-cue (indirect cue) button, all panel status buttons 
become blue, and you can set the fixture/group channels without sending them to 
the LanBox. Once you hit the space bar all values of the fixture/group are sent at 
once, and the i-cue button goes off.

• Command line: The field right of the i-cue button shows the entered key 
characters for CLI commands. CLI is very powerful as it enables you to do most 
common actions with just a few keystrokes. Multiple commands are allowed, but 
must be separated by a semicolon. For parameters the dash is allowed for a range, 
while comma can be used for separate parameters. The commands can be found in 
the last chapter. A sequence must end with enter/return/space/tab, while esc cancels 
the command. The clear key clears command except the first letter.

• Fixture presets: Four popups can hold multiple presets for 
fixture settings. The presets are built from library presets, and 
custom fixture presets. You can create quickly a preset by 
setting the channel(s) to the required value, and click on the 
chosen popup, with the option key pressed. You have the option 
to store the preset into the selected fixture(s) or into the fixture library file.

• Fixture controls: The layout of the fixture controls (except Master Intensity) is 
dependent on the selected fixture(s), but can have in general wheels, trackball and 
buttons. Every control section is called a panel, and a fixture has at least one panel 
with intensity wheel. The Master Intensity panel works only on intensity channel(s) 
of selected fixture(s). Remember the master changes the intensity independent of 
how a cue was programmed, so be careful with the master. The DMX value of a 
panel (channel(s)) can be changed by a wheel, trackball, button, or just by entering the value in the data 
field. The values can be entered as percentage (%), hex(h) or decimal (.), and can be relative by preceding 
the data with a plus or minus sign. The data field can also be incremented and decremented by one, by 
using the arrow up/down keys (or by 10 when the shift key is also pressed). Note: When multiple channels 
are selected and their values are not the same the value will be shown as e.g. "<100", meaning they are 100 
and lower. Likewise ">120" means 120 and higher.

• Panel options: Each panel has three options or states which can be active or not.
      1. The light channel(s) can be active (black values) or inactive (grey values).
      2. The light channel(s) can be connected (green) or disconnected from the mixer.
      3. The light channel(s) can be in Solo mode (red) or normal.
      You can change the state of each option by either clicking on the green/red buttons or hit the enter key to 

activate selected values (or backspace, enter, to disable them). If you want to activate all channels of a 
selected fixture/group at once, press option/alt and hit enter, to disable all channels option/alt backspace. 
Likewise, if you option (alt) click on the green or red buttons, all will go on/off

 
 

Edit and control fixtures

Page 8 LCedit+ reference manual v3.2.1



Single line editor

Before v3.1 of LCedit+ this was the main cue editor, but is replaced by 
the cuelist editor (see chapter 3 and the tutorial). The single line editor 
can still be very useful for fast cue corrections, so that's why it's still in 
LCedit+.

Before creating cue steps with light scenes (cues), be sure you have only 
one open control window, with a selected edit layer (if there is one). Fill 
in the cuelist number (e.g. 50) you want to create/edit into the Go field 
and click on the Edit button right of the field

Note: If there are no layers at all, you can create one with the New Layer 
menu command.

• First of all, check that the "Edit" layer is selected.
• Select a group or fixture for which you want to create a cuelist. Do not 

select other groups or fixtures during an edit, unless you know what 
your doing (think on the blank squares;-).

• Now set ALL channels of the group to the required values (e.g. use the 
Default in the "Other" preset button). To do so you can use the 
wheels/trackball and/or the DMX data fields. You can use the tab and shift tab to step through the 
channels, use arrow up/down keys for increment/decrement values (use shift-arrow key for larger steps). 
It's even possible to do select all fields and enter the data in all fields with the same value. Note: Once you 
have changed anything on the fixture window, the topline of the control window will be red.

• A cuestep with light info (Cue) also needs to know how long this step will be held before stepping to next 
step when the sequencer runs, and when you want to use the faders, how long the fade will last and what 
kind of fade you want to use. In LCedit+ this is called the "Step Action". If you 
would append the step to the cuelist right now, the default values of 3 Sec hold and 
3 Sec crossfade would be supplied.

• Optionally, if you have other action values in mind, click on the big field with 
"home" in it on the engine window. You will get a dialog "Edit Step Action" with 
the "Show" tab in front. Select the hold time from the lower left popup, the fade 
type and fade time from the right popups. For now be sure that the hold time is the 
same or larger as the fade time! Click OK when you are done. Note: If you use the 
"ever" value for hold time, a cuestep will not proceed with next one until you hit the space bar (when the 
sequencer is running). So for theatre people, set hold time to "ever" in order to have a not linked Cue.

• After doing "Append Step" from the engine menu, the "Go" field will be incremented and the outline 
colour of the engine window will change to green. Congratulations you made (into the LanBox-LC) your 
first light step, also called Cue.

• You can now append more steps, just by setting other DMX values (and optional other action values) and 
do append again. 

Once you have created several steps in a cuelist, you might want to check what you have made and possibly 
change them. There are several commands to do so, just click in the Go field and hit the "Esc" key. From 
now you can click on the Next/Prev buttons, or enter ".x" into the Go field, where x is the step number. 
Every time the step number is changed or entered the programmed fade action is also executed, so you can 
see what you have made.

Changing a step can be done instantly, once the fades of a step are ended. You only need to set the DMX 
field(s) to the new value(s), optionally change the action values and do "Replace Step". You can also insert a 
new step, created from the current one by changing the Go field (NO RETURN), and use the "Insert Step" 
menu command.

Note: After an insert, the original step number and all next steps are shifted one up. So if you have steps 1..5 
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and you insert at 3, the original step 3 becomes 4, while 4 becomes 5 and the original step 5 will now be 6. 
In order to delete a step, use the "Delete Step" command. The deleted step will be replaced by the next step, 
so they are all shifted down by one.
IMPORTANT: On a LCX, LCE or LCM your created cues are not yet permanently saved! Use the menu 
command "Save LanBox data" in order to save all your data into Flash.

Notes for theatre application with LCX, LCE or LCM
As it is common in theatre to use fixed cue numbers we have added a feature in the LCX, LCE and LCM to 
make fixed cue steps with light (cues). If you use Replace instead of Add after filling in the Go field, the cue 
will be written to that number and all numbers between previous cue and this one will be filled with blank 
remarks steps (action window, special tab). If you hold the option/alt key pressed it will be stored into next 
multiple of 5 step. So if you store your cues only at even steps xx.5, xx.10, etc. it will leave space for 
inserting one cue afterwards without renumbering (but don't use the add, insert or delete buttons!). If you 
want to delete a cue use replace with blank comment as action. Be aware that split fades (LCX, LCE & 
LCM only) "eats" two steps, so using steps 5,10,15, etc. is more convenient.
 

Using the sequencers and chasers (use "run" layers)

Each non-edit layer (a "run" layer) has a built-in sequencer, which can be used to step through a cuelist 
automatically. Before we describe the use of the sequencer, we have to explain a bit more about the use of 
layers.

• Use the top layer to run flash and blackout cuelists.
• Use one or more lower layers to run cuelists for created fixture groups.
• Reserve at least one layer for (show) control cues.
• Use the lowest layer (edit) for basic and manual lighting. 

All layers should be in "Copy" mix mode (default mode). This way ensures that flashes/blackout have the 
highest priority, while if nothing runs yet, you get automatically the background (manual) lighting. This also 
means that if you are editing while your show is running, it is not seen in your lighting until you have 
stopped (Go .0, or stop button) all running cuelists and cleared the layers (the LCX and LCM clears 
automatically at stop).

Note: You don't need to have multiple control windows (better not, as it's getting confusing) open, as even 
while editing in e.g. layer G you can enter e.g. "g10.1a" to run flash cue 10.1 in layer A (if a exists). With 
the LCX and LCM you can even enter g10.1zz and there will be a new unnamed layer created on top, which 
runs cue 10.1. This layer will disappear automatically when the cuelist is ended or stopped.

Edit and control fixtures
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Running cues and chases

Once a run layer is visible, the sequencer is activated, but not yet triggered. Once started, it steps through a 
cuelist until the end of a list and then jumps to "home" (step .0), where it waits for another trigger. There are 
several trigger possibilities:

• Enter the cuelist and step number (or dot step number only) into the Go field, and hit return (or enter, or 
click on the Go button) to start from specified cuelist and/or cuestep.

• Use the CLI (Command Line Interface), just by the e.g. following key sequence: g (for Go), 100.2 (cue 
number), b (layer B) followed by return.

• You can also just the space bar (or click on the start or next button). The sequencer will start from current 
step.

• A Go trigger command can also be sent by MIDI, serial or a (show) control program. 

While the sequencer is stepping it can temporary be frozen with the pause (||) button, stepping AND fading 
are suspended until the pause button is hit again. Tip: While pause is on, you can single step through the 
cuelist, just by using the space bar (or "Next" button, or cmd-=, or page-up key) to go to next step.

Sequencing is stopped by clicking the Stop/Run button, after which it goes immediate to the Home step, 
while running fades are finished. The same is achieved by entering Go .0 At any time you can use the 
"Next", Previous", Go button and Go field, in order to go to another step.

Note: When the sequencer is suspended by a "Wait on Step" option, the 
triangle of the Start/Stop button becomes orange.

The sequencers also have a "Chaser" option, which can be set by hand in the 
Advanced.. part of a control window (normally you should make a control 
cue to achieve this. see tutorial). There are several Chase options:

• Step upwards through the cuelist ( Chase Up, optional endless)
• Step downwards through the cuelist ( Chase Down, optional endless)
• Step up/down through the cuelist ( Chase Bounce, optional endless)
• Step random through the cuelist ( Chase Random, optional endless)
• Step bouncing through the cuelist ( Chase Bounce, optional endless)
• Change the speed of stepping between 50% and as fast as possible.

Note: As the fade times are NOT changed, it is only useful to change the chase speed, when you have a 
cuelist without fades (or turned off the faders with the master "F" button).

Edit and control fixtures
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The Configure Interface window

After starting LCedit+ and opening a New project, this is the first window you will 
see. The editor needs to know what kind of interface you want to use, in order to 
communicate with a LanBox. Note: On OS X or Windows only serial (USB) or 
TCP/IP can be used.

Note: If you want to connect via TCP/IP (LanBox-LCX, LCE), the default IP 
is 192.168.1.77 (mask is 255.255.255.0) so your computer should be set to any 
other IP in the 192.168.1.xx range.

Select the medium, port(s) or name, for AppleTalk and TCP/IP you can optionally save your password. Now 
give it a descriptive name, select the "Connect" checkbox and click "OK". The settings will be stored in your 
project file, in order to connect instantly when you double click the saved project file.

Note: If you wish to try LCedit+ without a LanBox, you can try to use our demo LanBox (if it is not in use) 
via the Internet. In that case you need to select TCP/IP and use the name demo.lanbox.com, with password 
777. (you need to have access to the Internet in order to use our demo box).

After clicking OK, LCedit+ will try to establish a connection with your LanBox. On a network connection it 
will ask for a password, use 777 as it is the default password of a LanBox. If everything goes well, you will 
read something like "Connected" in the control window right lower message box.

• Put the network name of your LanBox in the name field e.g. LanBox 1, so you know which LanBox you 
are using in this project (even when it changed to e.g. serial).

• Once the connection is made, save the project (File menu-> Save As..). 

LCedit+ supports the use of multiple lanboxes, so in order to have an overview and in order to change the 
current interface, you can open the Interfaces window with the menu 
command "Interfaces" in the Windows menu. An interface can be 
edited, added and deleted (if it is not in use) with commands in the 
Edit menu.

Note: If you wish to try LCedit+ without a LanBox, you can try to 
use our demo LanBox (if it is not in use) via the Internet. In that case 
you need to select TCP/IP and use the name demo.lanbox.com, with 
password 777. (you need to have access to the Internet in order to use 
our demo box).

After clicking OK, LCedit+ will try to establish a connection with your LanBox. On a network connection it 
will ask a password, use 777 as it is the default password of a LanBox. If everything goes well, you will read 
something like "Connected" in the control window right lower message box. Note: Put the name of your 
LanBox in the name field e.g. LC 1, so you know which LanBox(es) you are using in this project (even 
when it changed to e.g. serial). Once the connection is made, save the project (File menu-> Save As..).
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Monitors & Tools

LCedit+ has several built-in tools, in order to set global setting of the LanBox-LC, to manage files inside the 
LanBox-LC, a mapper to map (patch) all kind of post processing to DMX addresses and a backup/restore 
facility.
 
The monitor window shows the DMX values of the current 
selection. The selection can be the DMX output, DMX or 
analogue inputs, DMX values of any layer, or the mixer. It can 
be chosen by the popup button on the left side of the window.

Note: Red coloured means the data is changing (fading), while greyed data means the output is off or 
channel is inactive. Underlined data in engine monitoring emphases output On or channel is active.
 

All the global settings of the LanBox-LC+ can be edited in the Global Setting window (Tools menu 
command).

• LanBox SysEx ID, Name, password, baudrate (and on LCX & LCE IP 
settings) are used to identify a LanBox in serial, MIDI sysex and 
network environment.

• The DMX tab has settings for DMX out (and DMX in on a LCX). 
DMX output offset gives the possibility to shift the DMX channels 
with an offset of maximal 255 (512 on LCX and LCM). So together 
with active DMX channels, you e.g. use DMX channel 250 through 
375. The DMX-in settings allows you to select a certain input range 
and map it to a light channel range of a layer

• Engine to MIDI channels mapping is on the MIDI tab.
• You find 16 bit channels definitions.
 Note: If you want to remove a 16 bit channel, set "High" and "Low" 

both to zero 
• On the Digout tab you can map a light channel to a digital output 

channel of a LanBox-LCX. 
• We added recently an UDP tab, which is used for settings of 

distributing DMX over UDP (LCX and LCE). Besides broadcasting the mixer, it’s also possible to 
broadcast analogue-, DMX input, and DMX output for use with e.g. MAX. Only mixer broadcast can be 
received and copied to mixer or a layer.

 

With the Patcher Editor window, you can map DMX channels 
to light channels, change the gain per channel, set curves to 
DMX channels, set the slope limiting and even create curves in 
a graphical way. When creating a curve the grey line is the 
current curve, while the black line is the new to be created 
curve. For smooth curves use the round anchors, while with the 
square anchors you can make sharp corners.

All changes done in the patcher are updated in the LanBox real-
time, so you can see what you are doing. This changes are not 
stored into the LanBox permanently until you click the Store 
button in the patcher window.

Note: When the "I" button is enabled, a multi line selection will be updated with incremental data values.
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Backup and Restore

Using the Backup and Restore commands, 
transfers lighting files from/to your Mac or PC 
to/from the LanBox. All cues, scenes, patches 
etc., made in LCedit are actually stored in the 
LanBox. In order to save all LanBox files also 
on your Mac or PC, use the "Backup.." menu 
command. The files can be put back into the 
LanBox by using "Restore". All files are 
selected by default, but can be changed for 
selective backup/restore (Option/Alt click 
selects or deselects all).
Notes: From version 1.0b3, all backup files are 
tab separated text files, so they can be 
read/created by spreadsheet programs
 

 

Installing firmware

If you want to upgrade your LanBox-LC, or try the newest firmware, need to 
upload the LC+ firmware into the box. The following procedure can also be used 
to revert back to the LCII firmware if needed or to install older firmware.

• Choose the "Tools->Upload Firmware..." menu command and in the upload 
dialogue, click "Update".

• Choose the "LC+ firmware v1.06.dat" file if you have a LanBox-LC (the LCX, 
LCE and LCM have other firmware files!), the upload procedure is starting.

• WAIT UNTIL UPLOADING IS COMPLETELY FINISHED!

• After clicking the OK button, your LanBox will reconnect and the messages 
window should now list e.g. "LanBox-LC+, v1.06

        

Note: On a LanBox-LCX, firmware upload can only be done if you are connected via an USB connection.

Note: From LCX, LCE firmware version 2.00 you can also upload via TCP/IP. Be aware that this firmware 
can only be used with LCedit+ v3.2.1 or later.

.
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The library editor

With the built-in library editor you can create new fixture definitions in the 
library, but also modify excising definitions. Note: Make a backup of you 
entire library folder, before experimenting with the editor! When you need to 
use a fixture which is not in the library, you have the option to build a 
definition from scratch, or use a near model as template. When opening the 
library editor (Windows menu -> Library Editor), you see a sorted list of all 
fixture definitions in the library folder.

As it is easier to explain the fixture definition window with an 
already designed fixture, we choose the Martin Pro 518(m2) 
from the library list, and choose Duplicate from the Edit menu. 
This opens the Fixture Definition dialog, with the tab on design. 
First rename the fixture definition (like Pro 518 FvD).

Note: Do NOT use the fixture tab, unless you understand what 
the wording "Make subclass of a fixture definition" means. Also 
the patch tab is non-functional, only the Design and Presets tabs 
can be used.

On the design tab is a list of panels in order as they are showed 
on the control window. Each line contains the following 
parameters: The channel offset, the control type, the display 
format, panel separator on/off, and the panel label. The order of 
the panels can be changed by selecting a line and use the Move 
up and down buttons.
Important: Panel 1 should always be the Intensity panel!

Adding a panel can be done when no panel line is selected (click below the end of the list), and select a 
control from the control popup. Now label the panel and change the channel offset (default is next available 
channel). A panel can be deleted with the Delete button.

Next, if you want custom icons (or buttons) instead of the generic icons in a panel control, you need to make 
an icon strip of 12 or 16 pixels height (small or large wheel) and n times the height as width, like this: 

 After clicking on the button Icon strip, you will have the Edit Icon Strip window. With the 
edit menu you can Copy, Paste and Clear the strip. The number of steps (lines in the list) is depending on the 

width of your icon strip, so it should be a multiple of the height of the 
strip. Note: You can directly paste from Photoshop, but you can also 
drop a pre-made graphic file onto the icon strip window. An icon of the 
strip has a DMX value range in which the icon is shown, and optional 
the button number (for icon buttons). An icon can also be continues, 
e.g. see RGB or CMY colour wheels.
 
When your done with editing the fixture definition, click on the close 
button of the fixture definition window. Now you will get a Save 
dialog, in order to save the fixture file into one of the folders of the 
fixture library folder. 

Note: If your filename ends in .lcf, the file can also be used on systems running windows. 

Note: If you want to place your newly made fixture without restarting LCedit+, use the menu command 
File->Extra->Reload Library to refresh the library lists.
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The cuelist editor

As it is already 
described in the 
tutorial, we only note 
here some more 
advanced operations, 
like using the 
scripting language 
behind the editor.

If you have a cuelist 
like the picture right, 
and need to change, 
or recalculate a lot of 
steps and data, it's 
handy that you can 
export and import 
cuelists by 
copy/paste.

Note: If you select only cells instead of lines (steps), you can copy and paste directly between a 
spreadsheet program and the cuelist cells.

If you e.g. select all steps, and do copy and paste it in a text editor, you will see something like below:

// Cuelist 160 (22 steps), loaded 10-10-2003 11:29
write F0 7F 7F 06 44 to MIDI
write 06 01 00 13 17 to MIDI
write 04 7F 00 00 00 to MIDI
write F0 7F 7F 06 02 to MIDI
show d05 for 1.0s, crossfading for 0.75s
show d06 for 1.0s, crossfading for 0.25s
show d07 for 1.0s, crossfading for 1.0s
show d08 for 8.2s, crossfading for 8.2s
show d09 for 6.2s, crossfading for 1.0s
show d10 for 1.0s, crossfading for 0.80s
show d11 for 15s, crossfading for 0.30s
show d12 for 1.0s, crossfading for 0.00s
write F0 7F 7F 06 01 to MIDI
show d22 for ever, crossfading for 5.1s

:d05
2[000] 3[049] 4[000] 5[172] 6[081] 20[111]
21[142] 22[114] 23[106] 24[161] 25[118] 26[117]
27[065] 28[098] 30[098] 32[155] 33[064]

:d06
2[051] 3[049] 4[000] 5[172] 6[081] 20[111]
21[142] 22[114] 23[106] 24[161] 25[118] 26[117]
27[065] 28[098] 30[098] 32[155]

:d07
2[051] 3[049] 4[000] 5[172] 6[132] 20[111]
21[142] 22[114] 23[106] 24[161] 25[118] 26[117]
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27[065] 28[098] 30[098] 32[155]

:d08
2[051] 3[049] 4[000] 5[172] 6[132] 20[111]
21[142] 22[114] 23[106] 24[161] 25[118] 26[117]
27[065] 28[098] 30[098] 32[219] 33[064]

:d09
2[051] 3[049] 4[000] 5[172] 6[081] 20[111]
21[142] 22[114] 23[106] 24[161] 25[118] 26[117]
27[065] 28[098] 30[098] 32[219]

:d10
2[051] 3[049] 4[000] 5[110] 6[112] 20[111]
21[142] 22[114] 23[106] 24[161] 25[118] 26[117]
27[065] 28[098] 30[098] 32[219]

:d11
2[050] 3[049] 4[000] 5[102] 6[081] 9[000]
10[000] 11[000] 12[000] 13[000] 14[000] 15[000]
16[000] 20[111] 21[142] 22[114] 23[106] 24[161]
25[118] 26[117] 27[065] 28[098] 30[098] 32[219]

:d12
2[050] 3[049] 4[000] 5[102] 6[081] 9[000]
10[000] 11[000] 12[000] 13[000] 14[000] 15[000]
16[000] 20[111] 21[142] 22[114] 23[106] 24[161]
25[118] 26[117] 27[065] 28[098] 30[098] 32[219]

:d22
2[000] 3[108] 4[000] 5[170] 6[133] 20[000]
21[000] 22[000] 23[000] 24[000] 25[000] 26[000]
27[000] 28[192] 30[192] 32[000] 33[000]
 
  

The scripting commands can be found in the last chapter.
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LanBox Utilities

LanBox Utilities is a simple utility in which you can see how many 
cuelists and the number of steps of each cuelist are stored in the 
LanBox. You can also get a detailed overview of the memory usage in 
the LanBox-LC (not LCX, LCE or LCM).

Clicking on the list button gives a directory list, while the usage button 
provides a long (technical) list of file usage in the LC+, and the used 
and unused memory.

Note: Usage listing can be aborted by pressing the control key.
 

The Command Line Interface

While the graphical interface of LCedit+ is an advantage to beginners, there are moments you 
wished fast, short, key commands to get things done. The CLI interface was made for it, and 
also in order to make a single keystroke (see keystroke editor and macros) doing a whole bunch of actions. 
As soon as you type a CLI character the CLI interface is activated, until an end of sequence command is 
received.
 

Macros

With CLIs you have a fast way to control LCedit+, but what if you want to have a short way for sending 
commands to the LanBox (like setting the chaser, clearing an engine, etc)? The answer is Macros. A macro 
is a recorded sequence of lanbox commands, this means any command which can be send to the LanBox, 
can be recorded. 

Recording a macro is initiated (and ended) by the menu command Tools->Record Macro. A macro may 
contain up to 20 LanBox commands. When you end the recording, you will be 
asked a name for the macro. This name popups in the command macros lists on the 
control window (see picture).

A macro can be started by selecting it from the list, and click on the Run button. The macro lists are double 
in order to make two macro's ready to run. A fast way to run e.g. macro 2 is typing m2 (see CLI commands). 
Macros can be deleted with the Tools->Delete Macros... menu command.
 

Keystroke editor

With CLIs you have a fast way to control LCedit+, and with the 
addition of macros you can actually control anything with CLIs, 
but...  If you want just a single keystroke in order to simulate 
some CLIs, you can use the built-in keystroke editor to assign 
one key to do CLI commands.

The keystroke editor allows you to assign very unusual key 
combinations (like control-alt-shift-F3). Single keystrokes are 
also a must if you want to use very handy hardware button, jog, 
shuttle USB devices, like the Shuttle Pro of Contour.
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Using backup files as spreadsheet files

The file type of a backup files are tab separated text files. The advantage of the text files is that backup files 
can be read into any word processor and particularly into spreadsheet programs. This also makes it possible 
to make custom software that creates backup files, and the files can be read/edited in a spreadsheet program. 
If you save the spreadsheet file as a tab separated text file, they can be uploaded to the LanBox with restore.

A backup file is a tab separated text file. Each line contains data for a scene, each column contains data for a 
DMX channel. Each line is terminated with a <CR> ($0D).

The header, the first row, contains global information about the file. It consists 10 columns, with the 
following data: v2.00, LanBox name, 0, 0, 2, 0, 0, 0, cuelist HSB, cuelist LSB. After the first 10 columns the 
columns are filled with the numbers of used DMX channels (in ascending order) in this cuelist.

After the header a number of rows follow. Each row contains data of one cuestep, including the step action 
data. The first item in each line is the step number, preceded by the step type code and its 6 parameters (see 
LanBox reference manual page 82). Column 9 indicates whether it is absolute scene data (0), or relative 
scene data (1), and column 10 is empty.

Note: The cuestep numbers must be consecutive, otherwise LCedit+ can't restore the file. When generating a 
LanBox-LC+ backup file from a custom made program, you can best use the save option 'save range'.

 

Using multiple LanBoxes

You can use multiple LanBox interfaces within LCedit+, but there are some limitations, unless you use a 
LanBox-LCX and one or more LCEs (network distributed universes):

• Each fixture is assigned to a interface, you can make groups, but mixing of multiple interfaces within a 
group is not possible!

• Remember that each box has it's own cues, so two boxes is NOT 1024 channels, but 2 x 512 channels. The 
best thing to do is split your fixtures in such a way, you can make cues and chases for each universe.

• Keep in mind that you have to make a controller cue, which controls a second (third, etc) box e.g. via 
MIDI, in order to sync cues between boxes.
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System requirements

Mac
Any PPC Macintosh running OS 8.6 or later (including OSX), 16 bit color screen 800x600, 12 MB free 
RAM, LocalTalk port (or Ethernet and an iPrint-LT Ethernet to LocalTalk adapter). G3 or better and 
1024x768 16 bit color screen recommended. A free serial port (or USB to serial adapter) can be used instead 
of the network connection as well. For LanBox-LCX you need to have a free USB port, for LanBox-LCE 
you need to have an Ethernet connection.

Note: AppleTalk and MIDI can only be used on MacOS 8/9, on OSX it's serial (USB) or TCP/IP only.

PC
Any Pentium PC, Windows 98SE/2000/XP, 16 bit color screen 800x600 (1024x768 recommended), a free 
serial port (or USB to serial adapter). For LanBox-LCX you need to have a free USB port, for LanBox-LCE 
you need to have an Ethernet connection.
 

Windows overview

* Stage Window
The stage window (with an optional background picture), shows in the form of icons and/or labels your 
defined fixtures and/or light groups.

* Control Window
All controls of a selected group and engine are shown in the Control window.

* Cast Window
The cast window, shows in the form of a list your defined fixtures and/or light groups. The list can be 
sorted on name, light channel or DMX channel.

* Interfaces Window
The interface window, shows in the form of a list your defined interfaces with LanBox(es).

* Monitor Window
The monitor windows, shows the current DMX values and the status of the output, mixer or engine 
channels. Is useful for debugging complex light cues

* Cuelist Editor Window
Cue lists can be edited, table based in the cuelist edit window.

* LCutils Window
Lists the created cue lists and memory usage of a LanBox

* Stream Watcher Window
For debugging purpose, see the commands going the LanBox.

* Patch Editor Window
Overview of all mappings and patches.

* Library Editor Window
Lists all predefined fixtures in the library.
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Menu Commands overview

* File menu
          o New Project...
          o Open...
          o Close...
          o Save
          o Save As...
          o Revert to Saved
          o Import...
          o Export...
          o Extra
                + Reload Library
                + Renumber Selection
                + Reset preset numbers 
          o Page Setup...
          o Print...
          o Quit 

* Edit menu
          o Undo
          o Cut
          o Copy
          o Paste
          o Clear
          o Select All
          o Select Fixtures
          o Select Similar
          o Edit Item...
          o Duplicate Item
          o Delete Item
          o New Fixture...
          o New Interface...
          o Make Group... 

* View menu
          o Large Icon
          o Small Icon
          o Large (No Icon)
          o Small (No Icon)
          o No Indicator
          o Intensity Indicator
          o Position Indicators
          o Full Indicators
          o Show Numbering
          o Position Locked 
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Menu Commands overview

* Layer menu
          o New Layer
          o Delete Layer
          o Clear Layer
          o Edit Mode
          o Go Next
          o Go Previous
          o Go Next Cue
          o Go Previous Cue
          o Grab DMX Data
          o Copy Panel values
          o Paste Panel values 

* Tools menu
          o Global Settings...
          o LanBox Utilities
          o Patch Editor
          o Save LanBox data
          o Record Macro
          o Cancel Record
          o Delete Macros...
          o Keystroke Editor...
          o Backup...
          o Restore...
          o Upload Firmware...
          o Erase LanBox...
          o Debug Mode
          o Log To File 

* Window menu
          o New Stage Window
          o New Control Panel
          o New Cuelist Editor
          o New DMX Monitor
          o Auto Update
          o Update Now
          o Reconnect Interfaces
          o Interfaces
          o Library Editor
          o (Dynamic Window List) 
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Key actions overview

LCedit+ has several single key actions. Below you find an overview of the keys and their actions. Once you 
know these key commands (together with user defined keystroke commands), you can do extremely fast 
complex commands. A must for live shows, but also very handy to create cues very rapidly. Note: The cmd 
(apple) key is the ctrl key on Windows systems.

* <alt-tab> cycles over open windows (<ctrl-tab> on Windows systems.
* <cmd-alt-up> <cmd-alt-down> selects next or previous fixture or group.
* <cmd-shift-alt-up> <cmd-shift-alt-down> same as previous, but adds to selection. 
* <alt-pgup> or <alt-space> Go next cue (LCX, LCE & LCM only)
* <alt-pgdn> Go previous cue (LCX, LCE & LCM only)
* <cmd-up> and <cmd-down> select next and previous layer.
* <cmd-shift-up> and <cmd-shift-down> move current layer up and down.
* <space> is the Go Next step shortcut (unless in i-cue mode).
* <space> applies i-cue mode (<shift-space> cancels)
* i toggles icue mode (enable/cancel)
* u selects the Go field on the control window.
* v select the Intensity field on the control window.
* x select the Pan field on the control window.
* y select the Tilt field on the control window. 

* <control> when cursor is above the panels in the control window, shows the used channel number(s).
* In the "Go" field of a control window:
          o <up> and <down> increments and decrements the cuestep.
          o <shift-up> and <shift-down> in- and decrements the cuestep to multiple of 5.
          o <enter> Go to entered value in current layer.
          o <alt-enter> Go to entered value in a new layer. 
* In fixture control fields of a control window:
          o <up> and <down> increments and decrements the value.
          o <shift-up> and <shift-down> increments and decrements the value by 10.
          o <enter> in a field applies the data.
          o <escape> in a field cancels the data entry.
          o <alt-enter> activate all channels of selected fixture(s).
          o <alt-backspace> or <alt-del> de-activate all channels of selected fixture(s).  

* CLI command ; is used as command separator within a CLI command.
* CLI command g is a "Go" (example: g100.4a1 -- go 100.4 in layer A of interface 1, where a and 1 are 

optional)
* CLI commands k and l to select fixtures and groups (example: k1-10l2 or k2l1-10 -- select fixtures 1-10 

and group 2)
* CLI command m to run macros (example: m4-6,1 -- run macros 4, 5, 6, 1 (in that order))
* CLI command n selects a layer (example: nb -- selects layer B)
* CLI command p do presets (example: pc1o1,3 -- color preset 1 and "other" presets 1 & 3)
* CLI command r in order repeat last command (the cursor will be at the end of the field, so you can edit the 

last command or just press enter to repeat it unchanged)
* CLI command s sets channel (example: s1-4,12-15f=20 -- set ch1..4 and 12..15 to 20 in layer F)
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Action commands overview

Below you find the formal list of all actions. Use the action dialog to see the usage of all possible 
parameters.

* Shows a lighting scene for a certain time, with optional fade actions
          o show (<scene>|previous) [for] <time>
          o show (<scene>|previous) [for] <time> [,] fading [in|out] [cr] [for] <time>
          o show (<scene>|previous) [for] <time> [,] crossfading [cr] [for] <time>
          o show (<scene>|previous) [for] <time> [,] split [fading] (in|out) [cr] [for] <time>
              
* Instructs a layer to Go to a certain cue (step).
          o go <cuelist>.<cuestep> [in [layer] <layer>
          o go <cuestep> in [layer] <layer>
          o go (next|prev) [in [layer] <layer>]
          o go <jumplabel>
          o go (<cuestep>|<jumplabel> if input <inputnum> (within|outside) <range>
          o go (<cuestep>|<jumplabel> if channel <channelnum> (within|outside) <range>
              
* Loops and holds
          o loop <count> [times] [to] <jumplabel>
          o hold [for] <time>
          o hold until switch [is] (negative|positive)
              
* Layer control
          o suspend [layer] <layer>]
          o resume [layer] <layer>]
          o start [layer] <layer>
          o halt [layer] <layer>
          o reset [layer] <layer>
               
* Layer and sequencer modes
          o set attributes [of [layer] <layer>] to (none | (fade|output|solo|and)+ )
          o set [layer] [<layer>] to (no output|copy|mix HTP|mix LTP|add)
          o set [layer] [<layer>] to mix [transparent] (at <percentage>|from <percentage> to <percentage> in 

<time>)
          o set [layer] [<layer>] to stop chaser
          o set [layer] [<layer>] to chase [up|down|random|bounce] [loop] (at <percentage>|from <percentage> 

to <percentage> in <time>
              
* Writes up to 5 bytes to a stream. Currently the only stream is "midi"
          o write <hexstring> [ to <stream> ] 
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